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ΠΕΡΙΛΗΨΗ 
  

Η παρούσα πτυχιακή εργασία ασχολείται με την σύγκριση δυνατοτήτων των 

προγραμμάτων προσομοίωσης τυπωμένων πλακετών (pcb) και συγκεκριμένα 

των δύο προγραμμάτων eagle και orcad. Τα κριτήρια σύγκρισης που θέσαμε είναι 

η απλότητα, η ευχρηστία σε μη εξοικειωμένο χρήστη και ο μέσος χρόνος που 

απαιτείται για την πλήρη ολοκλήρωση ενός κυκλώματος. Ως κύκλωμα αναφοράς 

χρησιμοποιήσαμε ένα κύκλωμα με τον επεξεργαστή 8086 σε συνδεσμολογία 

minmode. Κατά την σχεδίαση του κυκλώματος μας στα δύο προγράμματα που 

προαναφέραμε καταλήξαμε σε κάποια συμπεράσματα τα οποία παραθέτουμε 

μέσα από την πτυχιακή μας εργασία. 

 

 

ABSTRACT 
 

The present final thesis deals with the comparison of possibilities of 

specially focused programs for the design, simulation and production of 

printed circuit boards (pcb). More precisely between eagle and orcad 

programs. As factors of comparison we used simplicity, user inexperience 

mean time for a circuit completion. The circuit which was used is a 8086 

based minmode setup. At the designing of our circuit in the two programs 

that we mentioned before we led to certain conclusions which we mention 

through our final work. 
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ΚΕΦΑΛΑΙΟ 1 

 
Εισαγωγή 

 

Σε αυτό το κεφάλαιο αναλύεται το αντικείμενο της πτυχιακής εργασίας και 

γίνεται μια ιστορική αναδρομή. 

 
1.1 Περιγραφή του αντικειμένου της πτυχιακής εργασίας  

Αντικείμενο της παρούσας πτυχιακής εργασίας είναι η σύγκριση των 

προγραμμάτων eagle και orcad. Στο τέλος θα υπάρχει σύνοψη των 

συμπερασμάτων που θα έχουμε καταλήξει μετά την υλοποίηση του κυκλώματος 

μας και στα δύο προγράμματα. 

 
1.2 Ιστορική αναδρομή  

Πριν την ανάπτυξη των προγραμμάτων Προσομοίωσης όλα τα σχέδια, οι 

μελέτες και οι αναλύσεις κυκλωμάτων γινόντουσαν μετά την υλοποίηση του 

κυκλώματος με αποτέλεσμα τα κυκλώματα για να τελειοποιηθούν να περνάνε 

από πολλά πειραματικά στάδια. Η διαδικασία αυτή ήταν αρκετά χρονοβόρα και 

ασύμφορη οικονομικά . Έτσι με την ανάπτυξη προγραμμάτων Προσομοίωσης 

ξεπεράστηκε αυτό το πρόβλημα με αποτέλεσμα πλέον να αποτελούν μεγάλο 

κομμάτι στην μελέτη και ανάλυση κυκλωμάτων. Τα προγράμματα Προσομοίωσης 

επηρέασαν την εξέλιξη της ηλεκτρονικής βιομηχανίας και κατά συνέπεια και 

στους ρυθμούς της ανάπτυξης της τεχνολογίας 
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ΚΕΦΑΛΑΙΟ 2 

Προγράμματα Προσομοίωσης Κυκλωμάτων 
 
2.1 Τι είναι τα προγράμματα Προσομοίωσης κυκλωμάτων 
 

Τα προγράμματα Προσομοίωσης κυκλωμάτων χρησιμοποιούν μαθηματικά 

μοντέλα για να αναπαράγουν τη συμπεριφορά μιας πραγματικής ηλεκτρονικής 

συσκευής ή κάποιου κυκλώματος. Το λογισμικό Προσομοίωσης δίνει τη 

δυνατότητα προσομοίωσης της λειτουργίας του κυκλώματος και αποτελεί ένα 

πολύτιμο εργαλείο ανάλυσης. Η ικανότητα του λογισμικού να πραγματοποιεί 

εξαιρετικά ακριβείς μοντελοποιήσεις οδήγησε πολλά πανεπιστήμια να το 

χρησιμοποιήσουν για την εκπαίδευση ηλεκτρολόγων και ηλεκτρολόγων 

μηχανικών. 

 Η προσομοίωση ενός κυκλώματος πριν την πραγματική δημιουργία του μπορεί 

να συμβάλει στην αποτελεσματικότητα του σχεδιασμού. Συγκεκριμένα στα 

ολοκληρωμένα κυκλώματα,τα υλικά είναι ακριβά,τα breadboards δεν είναι 

πρακτικά, και η λεπτομερής συμπεριφορά των εσωτερικών σημάτων είναι πολύ 

δύσκολη,γι' αυτό το λόγο ο σχεδιασμός ολοκληρωμένων κυκλωμάτων βασίζεται 

σε μεγάλο βαθμό στην Προσομοίωση. Ο πιο γνωστός προσομοιωτής 

αναλογικών κυκλωμάτων είναι το SPICE και οι πιο γνωστοί Προσομοιωτές 

ψηφιακών κυκλωμάτων είναι αυτοί που βασίζονται στην Verilog και στην VHDL. 

   Μερικά λογισμικά Προσομοίωσης παρέχουν ένα πρόγραμμα επεξεργασίας 

σχηματικού, μια μηχανή προσομοίωσης, πρόγραμμα εμφάνισης κυματομορφών 

στην οθόνη του υπολογιστή και τη δυνατότητα να φτιάξει ο χρήστης πιθανά 

σενάρια εύκολα και άμεσα. Το λογισμικό περιέχει βιβλιοθήκες με όλα τα γνωστά 

εξαρτήματα και μοντέλα για τον σχεδιασμό και την Προσομοίωση ενός 

κυκλώματος, οι βιβλιοθήκες ενημερώνονται από τους προγραμματιστές του 

προγράμματος Προσομοίωσης αλλά και από κάθε εταιρία παραγωγής 

εξαρτημάτων χρήσιμων για τη δημιουργία κυκλωμάτων. 
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Κατηγορίες προγραμμάτων Προσομοίωσης κυκλωμάτων 

 

Τα προγράμματα Προσομοίωσης κυκλωμάτων χωρίζονται σε δυο κατηγορίες:    

Προσομοίωσης Αναλογικών Κυκλωμάτων 
Προσομοίωσης Ψηφιακών Κυκλωμάτων 
 

 Αν και υπάρχουν προγράμματα Προσομοίωσης μόνο για αναλογικά κυκλώματα 

οι πιο γνωστοί προσομοιωτές συνήθως περιλαμβάνουν και αναλογική και 

ψηφιακή Προσομοίωση,και είναι γνωστοί ως μικτής λειτουργίας προσομοιωτές 

(mixed-mode simulators). Αυτό σημαίνει ότι κάθε Προσομοίωση μπορεί να 

περιέχει εξαρτήματα αναλογικά , ψηφιακά  ή συνδυασμό τους. 

 

 
Προσομοίωση εναντίων πραγματικότητας 

 
   Μετά την κατασκευή του κυκλώματος σε πυρίτιο πιθανών να προκείψουν 

διακυμάνσεις στη λειτουργία του ,αυτό γίνεται γιατί οι προσομοιωτές δεν 

λαμβάνουν υπ'οψην τους τις διαφορές που θα προκείψουν αφού το κύκλωμα 

κατασκευαστεί σε πυρίτιο. Οι διαφορές αυτές μπορεί να είναι μικρές,αλλά αν 

συγκεντρωθούν πολλές μπορούν να επηρεάσουν την έξοδο ενός chip 

δραμματικά. Ο παράγοντας της θερμοκρασίας μπορεί να υπολογιστεί και να 

προσομοιωθεί. 
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2.2 Διαδεδομένα Προγράμματα Προσομοίωσης 
 

• SPICE (Simulation Program with Integrated Circuit Emphasis) 
 
   Ο simulator SPICE είναι ένα πρόγραμμα Προσομοίωσης που η λειτουργία του 

έλαβε χώρα πριν από σαράντα περίπου χρόνια. Στα μέσα της δεκαετίας του ‘60 

η IBM ανέπτυξε το πρόγραμμα ECAP, το οποίο αρκετά αργότερα 

χρησιμοποιήθηκε ως σημείο αναφοράς από το πανεπιστήμιο του Berkeley για 

την ανάπτυξη του προγράμματος CANCER. Μέχρι τις αρχές της δεκαετίας του 

‘70 δεν υπήρχαν εργαλεία για την αυτόματη ανάλυση των ηλεκτρονικών 

κυκλωμάτων, γεγονός που είχε ως επακόλουθο κάθε τέτοια διαδικασία να 

εφαρμόζεται σχεδόν εξ’ ολοκλήρου από το ανθρώπινο δυναμικό, παρ’ ότι η 

πολυπλοκότητα τους αυξανόταν ολοένα και περισσότερο. Η διαρκής εξέλιξη, 

λοιπόν, των ηλεκτρονικών κυκλωμάτων έδωσε το έναυσμα σε μια ομάδα του 

πανεπιστημίου του Berkeley να αναπτύξει την πρώτη έκδοση του SPICE 

(Simulation Program with Integrated Circuits Emphasis), με βάση το πρόγραμμα 

CANCER. Ουσιαστικά, δημιούργησε έναν simulator γενικού σκοπού, ο οποίος 

επέτρεπε την ανάλυση αναλογικών κυκλωμάτων δίχως την ανάγκη της 

κατασκευής τους. 

   Στο SPICE, το κύκλωμα και η εκάστοτε απαιτούμενη ανάλυση βρίσκονται σε 

ένα κείμενο μαζί με δηλώσεις και εντολές. Το κείμενο αυτό διαβάζεται από το  

SPICE και έχοντας ως προϋπόθεση ότι δεν υπάρχουν λάθη στις δηλώσεις, στις 

εντολές και στην σύνδεση του κυκλώματος, δημιουργεί την Προσομοίωση. 

   Η επιτυχία του προγράμματος αυτού οφείλεται στην γενικότητα που παρείχε, 

οδηγώντας σταδιακά στην δημιουργία μιας σειράς από εκδόσεις του SPICE. Το 

1984 κατασκευάστηκε από την MicroSim Corporation η πρώτη έκδοση για 

προσωπικούς υπολογιστές, το PSPICE. Οι εκδόσεις του PSPICE με την 

πάροδο των χρόνων ανανεώνονταν διαρκώς, έχοντας φτάσει σήμερα στην 

έκδοση 9.x. 

   Το SPICE, όντας, πλέον, ένα από τα κυριότερα εργαλεία Προσομοίωσης των 

ηλεκτρονικών κυκλωμάτων, αποτελεί αναφορά και βάση για πλήθος 

προγραμμάτων ανάλογων εφαρμογών που κυκλοφορούν. 



ΣΥΓΚΡΙΣΗ  ΔΥΝΑΤΟΤΗΤΩΝ ΠΡΟΓΡΑΜΜΑΤΩΝ ΠΡΟΣΟΜΟΙΩΣΗΣ ΤΥΠΩΜΕΝΩΝ 
ΠΛΑΚΕΤΤΩΝ (PCB) 
 

20 
Αγγελίδης Γεώργιος , Αρβανίτης Νικήτας 

 

 
 
 

• Verilog 
 
   Η Verilog είναι μια γλώσσα περιγραφής υλικού(Hardware Description 

Language) και χρησιμοποιείται για την μοντελοποίηση ηλεκτρονικών 

συστημάτων. Η Verilog χρησιμοποιείται κατά βάση για τη σχεδίαση, επαλήθευση 

και εκτέλεση ψηφιακών και λογικών κυκλωμάτων. Χρησιμοποιείται επίσης για 

την επαλήθευση των αναλογικών και μικτού σήματος κυκλωμάτων. Εξίσου 

γνωστή γλώσσα είναι και η VHDL. 

 
• PSpice 

 
   To PSpice είναι ένα πρόγραμμα που χρησιμοποιεί τον αλγόριθμο του SPICE 

για την προσομοίωση ψηφιακών και αναλογικών κυκλωμάτων στο λειτουργικό 

σύστημα Microsoft Windows. Το όνομα του σημαίνει: Personal computer 

Simulation Program with Integrated Circuit Emphasis (Πρόγραμμα 

προσομοίωσης με έμφαση στα ολοκληρωμένα κυκλώματα για προσωπικούς 

υπολογιστές). 

 
• Ltspice 

 
   Το Ltspice είναι ένα δωρεάν υψηλής απόδοσης λογισμικό Προσομοίωσης με την 
χρήση του SPICE. Το Ltspice παρέχει ακόμα ένα λογισμικό σχηματικού και ένα 
λογισμικό προβολής κυματομορφών. 
 

 
Εικόνα 2.2.1:Περιβάλλον Ltspice 
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• NI Multisim 

 
   To NI Multisim είναι 

ένα πρόγραμμα 

σχεδίασης σχηματικού 

και Προσομοίωσης. Το 

NI Multisim είναι ένα από 

τα λιγοστά προγράμματα 

προσομοίωσης που 

χρησιμοποιεί ακόμα τον 

γνήσιο αλγόριθμο του 

SPICE που έφτιαξε το 

Berkeley University. 
Εικόνα 2.2.2: Περιβάλλον NI Multisim 

 
• Quite Universal Circuit Simulator (Qucs) 

 
 
   Το Qucs είναι ένα ανοιχτού κώδικα λογισμικό προσομοίωσης     ηλεκτρονικών 

κυκλωμάτων της εταιρίας GPL. Παρέχει τη δυνατότητα δημιουργίας κυκλώματος 

με γραφική διεπαφή χρήστη και την προσομοίωση του μεγάλου σήματος , μικρού 

σήματος και τη συμπεριφορά θορύβου του κυκλώματος. Οι καθαρά ψηφιακές 

προσομοιώσεις υποστηρίζονται επίσης με τη χρήση της VHDL και της Verilog. Το 

Qucs υποστηρίζει μια αυξανόμενη λίστα αναλογικών και ψηφιακών εξαρτημάτων 

καθώς και τα υποκυκλώματα του SPICE. Προορίζεται να είναι πολύ πιο απλό στη 

χρήση και το χειρισμό από τους άλλους προσομοιωτές κυκλωμάτων. 

 

 

 

 

 

 
Εικόνα 2.2.3: Περιβάλλον Quite Universal Circuit Simulator
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• Oregano 

 
    Το Oregano είναι ένα πρόγραμμα για σχεδιασμό σχηματικού αλλά και 

Προσομοίωση ηλεκτρονικών κυκλωμάτων. Προορίζεται για λειτουργικά 

συστήματα ανοιχτού κώδικα τύπου UNIX και υλοποιεί την προσομοίωση με την 

χρήση μηχανών όπως το ngspice και το Gnucap. Παρόμοιο λογισμικό είναι και το 

gEDA. 

 

 

 

 

 

 

 
 

Εικόνα 2.2.4:Περιβάλλον Oregano 

• CircuitLogix 
 
   

 Το CircuitLogix είναι λογισμικό προσομοίωσης ηλεκτρονικών κυκλωμάτων που  

χρησιμοποιεί το PSpice για ναΠροσομοιώσει χιλιάδες ηλεκτρονικές 

συσκευές,μοντέλα και κυκλώματα. Το CircuitLogix υποστηρίζει προσομοίωση σε 

αναλογικά,ψηφιακά και μικτού σήματος κυκλώματα, και η Προσομοίωση με την 

χρήση του SPICE δίνει ακριβή αποτελέσματα που συμβαδίζουν με πραγματικές 

μετρήσεις. Η επαγγελματική έκδοση του CircuitLogix περιλαμβάνει πάνω από 

10.000 μοντέλα συσκευών, ακόμα περιλαμβάνει 8 εικονικά όργανα.Περιλαμβάνει 

επίσης το 3DLab, ένα λογισμικό που συνδυάζει ένα εκπαιδευτικό διαδραστικό 

περιβάλλον τριών διαστάσεων με ηλεκτρονικές συσκευές και εργαλεία για να 

ενισχύσει την κατανόηση των ηλεκτρονικών από τον χρήστη. 
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• www.circuitlab.com 

 
   Το Circuit Lab αποτελεί μια καινοτομία στον τομέα της Προσομοίωσης, είναι 

μια διαδικτυακή εφαρμογή προσομοίωσης ηλεκτρονικών κυκλωμάτων. Ο 

χρήστης χωρίς να χρειαστεί να κάνει κάποια εγκατάσταση ανοίγει τον 

διαδικτυακό περιηγητή τουκαι απλά μπαίνει στην ιστοσελίδα 

www.circuitlab.com. Εκεί εισέρχεται σε ένα γραφικό περιβάλλον σχεδίασης 

σχηματικού (Capture) και αφού σχεδιάσει το κύκλωμα του έχει τη δυνατότητα 

να κάνει Προσομοίωση του κυκλώματος και να το αναλύσει. 

 
 
 
 
 
 

 
 

 
 
 
 
 
 
 

           Εικόνα 2.2.5:Περιβάλλον circuitlab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.circuitlab.com/
http://www.circuitlab.com/
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2.3: Προσομοίωση εναντίον Εξομοίωσης 

  
   Σε αυτό υποκεφάλαιο θα θέλαμε να διευκρινήσουμε την διαφορά μεταξύ 
προσομοίωσης και εξομοίωσης: 

 
-Το "προσομοίωση", "προσομοιωτής" είναι η μετάφραση στα ελληνικά των 
"simulation", "simulator". 
 
-To "εξομοίωση", "εξομοιωτής" είναι η μετάφραση στα ελληνικά των 
"emulation", "emulator". 
 
Μάλλον ο "εξομοιωτής" κάνει συγχρόνως και "προσομοίωση". 
 
  Τώρα, σαν χρήση από την τεχνολογική πλευρά: ο "εξομοιωτής" είναι μια 
ιδεατή ή εικονική (virtual στα αγγλικά) μηχανή που μπορεί να περιγράψει την 
συμπεριφορά ή λειτουργία μιας πραγματικής μηχανής ή διάταξης ή 
συστήματος μηχανής - περιβάλλοντος. 
   Από την άλλη πλευρά η "προσομοίωση" έχει να κάνει με την ιδεατή 
περιγραφή ενός φαινομένου και την εικονική αναπαράστασή του. Με αυτή την 
έννοια, ένας εξομοιωτής κάνει και προσομοίωση. 
   
 
 
 
 
 

 

 

 

 

 
 
 
 
 
Πηγή: http://users.sch.gr/symfo/sholio/sizitontas/o/17.exomiosi.htm 

 



ΣΥΓΚΡΙΣΗ  ΔΥΝΑΤΟΤΗΤΩΝ ΠΡΟΓΡΑΜΜΑΤΩΝ ΠΡΟΣΟΜΟΙΩΣΗΣ ΤΥΠΩΜΕΝΩΝ 

ΠΛΑΚΕΤΤΩΝ (PCB) 
 

25 
Αγγελίδης Γεώργιος , Αρβανίτης Νικήτας 

 

ΚΕΦΑΛΑΙΟ 3 

 
 

ΚΑΝΟΝΕΣ  ΣΧΕΔΙΑΣΗΣ  ΤΥΠΩΜΕΝΩΝ  ΠΛΑΚΕΤΩΝ 
 

   Πριν προχωρήσουμε στην κατασκευή µιας πλακέτας πρέπει να 

ακολουθήσουμε κάποιους κανόνες ώστε να ελαχιστοποιήσουμε την 

πιθανότητα αποτυχίας, οι οποίοι είναι οι εξής: 

 

•     Οι διαδροµές των σηµάτων και της τροφοδοσίας θα πρέπει να σύντομες με 

το ελάχιστο δυνατό µήκος. 

 

•  Να εξασφαλίσετε το µέγιστο δυνατό πλάτος για τις διαδροµές της 

τροφοδοσίας και της γείωσης και να βρίσκονται κοντά µεταξύ τους.  

 

•    Ελάχιστος αριθµός των περασµάτων (vias).   

 

•     Kρατήστε τους ακροδέκτες των εξαρτηµάτων στο ελάχιστο µήκος.  

 

•   Προτεινόμενες διαδροµές για τις αλλαγές κατεύθυνσης είναι γωνίες των 45 

µοιρών αντί 90. 

 

•     Συνδέστε έναν κεραµικό πυκνωτή (ceramic capacitor) περίπου 0.1 µF κατά 

µήκος της τροφοδοσίας Vcc σε κάθε ψηφιακό ολοκληρωµένο.  

 

•   Τα διαφορετικά επίπεδα πρέπει να υποδηλώνονται στο σχέδιο της πλακέτας 

(π.χ.) διαδροµές εξαρτηµάτων κ.τ.λ.  

 

•    Να χρησιμοποιείται ετικέτα προσδιορισµού της πλακέτας. 
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•    Προτινόμενες ελάχιστες αποστάσεις 10 mils µεταξύ των traces.   

 

•    Χρησιµοποιήστε νησίδες (πίστες-pads) τουλάχιστον 60 mils για όλα τα 

εξαρτήµατα. (1 mil=0.001 inch) 

 

•    Αποφυγή σχεδιασμού πλακέτας µε  µικρές διαστάσεις. Όσο µεγαλύτερη  η 

πλακέτα τόσο λιγότερα προβλήµατα θα εμφανιστούν όταν θα συγκολλήσετε τα 

εξαρτήµατα. (Το µέγεθος της PCB είναι ανάλογο µε το συνολικό κόστος. Οι 

µέγιστες διαστάσεις να µην υπερβαίνουν τις 9’’x 12’’ (’’= ίντσα=2.54 cm)).  

 

•    Για την διασύνδεση των εξαρτηµάτων χρησιµοποιούμε ιδανικά αγώγιµες 

διαδροµές (tracks ή traces) µε πλάτος µεγαλύτερο από 12 mils.  

 

•    Το µέγεθος της τρύπας για TH  ή της νησίδας για SMT εξαρτήµατα θα 

εξαρτάται από τις διαστάσεις του εξαρτήµατος.  

 

•    Για να πετύχουμε το ελάχιστο κόστος της πλακέτας προτίνεται να 

χρησιµοποιούμε τρύπες ενός µεγέθους και αγώγιµες διαδροµές ενός πλάτους. 

 

•    Πάντα να χρησιµοποιείτε µια γραµµή για τον καθορισμό της περιοχής 

«εκτός πλακέτας». Αυτή η γραµµή πρέπει να περικλείει όλη την πλακέτα και να 

καθορίζει τις τελικές διατάσεις της.  

 

 

 
 
Πηγή κανόνων σχεδίασης: 
http://www.electronics.teipir.gr/PersonalPages/papageorgas/downloa
d/2/shmeiwseis/pcb_fuse_translation_3.pdf 
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   Παρακάτω παραθέτουμε κάποιες φωτογραφίες μέσα από τις οποίες 
βλέπουμε τους τρόπους για να συμορφωθούμε με τους γενικούς κανόνες 
σχεδίασης,που προαναφέραμε,ανάλογα και με τις απαιτήσεις του 
μηχανήματος σε κάθε περίπτωση : 
 

 
 
Εικόνα 3.1 :Καταγραφή από το μενού DRC όπου ρυθμίζουμε το πάχος του χαλκού 

του κάθε επιπέδου της πλακέτας. 
 
 

 
Εικόνα 3.2 :Ελάχιστες αποστάσεις μεταξύ των αγωγών πάνω στα στρώματα.Πολύ 

κρίσιμος παράγοντας που έρχεται σε απευθείας συνάρτηση με τον εξοπλισμό 
παραγωγής. 
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Εικόνα 3.3:Ρύθμιση διαστάσεων μεταξύ αγωγών και πραγματικών αντικειμένων. 
 
 
 

 
 
                     Εικόνα 3.4: Ρύθμιση μεγέθους αγωγών-σημάτων. 
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Εικόνα 3.5:Ρύθμιση ελάχιστης και μέγιστης διαμέτρου του pad συγκόλλησης. 
 
 
 

 
 
                      Εικόνα 3.6: Ρύθμιση σχήματος pads και smds. 
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Εικόνα 3.7:Ρύθμιση πάχους για το thermal isolation όταν χρησιμοποιούμε πολύ 

μεγάλες νησίδες γειώσεως ιδιαίτερα απαραίτητο κατά την διαδικασία συγκόλλησης. 
 
 

 
 

Εικόνα 3.8: Ρύθμιση των τιμών της μάσκας των εξαρτημάτων. 
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Εικόνα 3.9: Ρύθμιση του μεγέθους πλέγματος για την τοποθέτηση των εξαρτημάτων. 
 
 
 

 

 
 
 

Εικόνα 3.10: Επιλογή ενεργών επιπέδων. 
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Εικόνα 3.11: Επιλογές Autoroute. 
 
 
 

 
 

Εικόνα 3.11: Επιλογές Autoroute. 
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Εικόνα 3.11: Επιλογές Autoroute. 
 
 
 
 

Εικόνα 3.11: Επιλογές Autoroute. 
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3.1 ΠΙΝΑΚΑΣ ΑΝΑΛΟΓΙΑΣ ΡΕΥΜΑΤΟΣ ΜΕ ΠΑΧΟΣ ΑΓΩΓΩΝ 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 

3.2 ΠΙΝΑΚΑΣ ΑΝΑΛΟΓΙΑΣ VOLTAGE ΜΕ BOARD 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

AMPERE ΠΑΧΟΣ 

ΑΓΩΓΩΝ(mm) 
1 0.25 
2 0.76 
3 1.27 
4 2.03 
5 2.79 
6 3.81 
7 4.57 
8 5.59 
9 6.60 
10 7.62 

VOLTAGE BOARD (mm) 
0-50 0.13 
51-100 0.13 
101-150 0.40 
151-250 0.40 
251-500 0.75 
>500 0.00305mm/V 
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ΚΕΦΑΛΑΙΟ 4 

ΤΥΠΩΜΕΝΕΣ ΠΛΑΚΕΤΕΣ (PCB) 
  
4.1 Ορισμός 
   Μία πλακέτα τυπωµένου κυκλώµατος (Printed Circuit Board PCB ή Printed 

Wiring Board PWB ή Perforated Circuit Board) στην πιο απλή της μορφή είναι 

μία λεπτή πλακέτα από μονωτικό υλικό που περιλαμβάνει τα εξαρτήματα του 

κυκλώματος και τους αγωγούς για την σύνδεση τους. 

   Οι ακροδέκτες των εξαρτηµάτων είναι συνδεδεμένοι με τις νησίδες ή πίστες, 

οι οποίες είναι τµήµατα της διαδροµής των αγωγών µε αρκετό χώρο ώστε να 

πραγματοποιηθεί η  κόλληση  µεταξύ του εξαρτήµατος και του αγωγού. Για να 

επιτυγχάνεται η στήριξη των εξαρτημάτων με τον καλύτερο δυνατό τρόπο 

υπάρχουν δύο επιλογές, είτε να έχουν τρύπες και να διαπερνούν την πλακέτα 

(through-hole) ή το εξάρτηµα να τοποθετείται και να γίνεται απευθείας η 

κόλλησή του στην πίστα (surface-mount). 
 
 
 
4.2 Ταξινόµηση PCB 

   Οι συνεχείς βελτιώσεις στην τεχνολογία κατασκευής PCB μας οδηγούν στο 

να υπάρχει µια ποικιλία στους τύπους PCB ανάλογα με την συμβατότητα  µε 

τα νέα σχέδια των ηλεκτρονικών εξαρτηµάτων. Οι διαφορετικές τεχνολογίες 

PCB έχουν σαν αποτέλεσμα να παρουσιάζονται αρκετές επικαλύψεις μεταξύ 

τους και κάνουν τον διαχωρισμό τους αρκετά δύσκολο. Με την λίστα που 

ακολουθεί προσπαθoύµε να τοποθετήσουµε όλους τους τύπους PCB στις 

τρεις κύριες κατηγορίες παρακάτω: 

-Τυπωµένη πλακέτα µονής ή απλής όψης (single-sided PCB)  

-Τυπωµένη πλακέτα διπλής όψης (Double-sided PCB)  

-Τυπωµένη πλακέτα πολλαπλών στρωµάτων (Multi-layer PCB)  
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Τυπωµένη πλακέτα µονής όψης (single-sided PCB) 

 
 
   Σε µία πλακέτα µονής όψης στις περισσότερες περιπτώσεις όλες οι 

αγώγιµες διαδροµές τοποθετούνται στην μια πλευρά ενώ τα εξαρτήµατα 

στην άλλη. Υπάτρχει όμως και η πιθανότητα τα ηλεκτρονικά εξαρτήµατα να 

βρίσκονται στην ίδια πλευρά µε τις διαδροµές ή και στις δύο πλευρές 

ανάλογα µε την πολυπλοκότητα του σχεδίου. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Σχήμα 1:Τυπωµένη πλακέτα µονής όψης (single-sided PCB) 
Πηγή:http://www.electronics.teipir.gr/PersonalPages/papageorgas/down
load/2/shmeiwseis/pcb_fuse_translation_3.pdf 

 
 

 
Τυπωµένη πλακέτα διπλής όψης (double-sided PCB) 

 
   Οι πλακέτες PCB της κατηγορίας αυτής χρησιµοποιούν αγώγιµες διαδροµές 

και στις δύο πλευρές της πλακέτας. Όπως και στην προηγούμενη  κατηγορία 

τα εξαρτήµατα µπορούν να τοποθετηθούν σε όποια πλευρά επιθυμούμε ή και 

στις δύο. Ο συνδυασμός αυτός έχει ως αποτέλεσμα να εξασφαλίζουμε 

µεγαλύτερη πυκνότητα εξαρτηµάτων σχετικά µε τα PCB µονής όψης. Οι  

συνδέσεις µεταξύ των διαδροµών των αγωγών στα δύο επίπεδα της πλακέτας 

επιτυγχάνεται µε τις εξής διαφορετικές µεθόδους όπως, ακίδες µεταξύ των 

επιπέδων, καλώδια, τους ακροδέκτες των εξαρτηµάτων και επιµεταλλωµένες 

τρύπες. Η τελευταία µέθοδος είναι και  η πιο συνηθισμένη στις μέρες μας και η  

 

 

http://www.electronics.teipir.gr/PersonalPages/papageorgas/download/2/shmeiwseis/pcb_fuse_translation_3.pdf
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υλοποίησή της γίνεται με την επικάλυψη του τοιχώµατος της οπής µε αγώγιµο 

υλικό. Οι επιµεταλλωµένες τρύπες οι οποίες χρησιµοποιούνται μόνο για την 

διασύνδεση αγώγιµων διαδροµών µεταξύ των δύο αντίθετων επιπέδων της 

πλακέτας είναι γνωστές σαν «περάσµατα» (vias). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Σχήμα 2:Τυπωµένη πλακέτα διπλής όψης (double-sided PCB) 

Πηγή:http://www.electronics.teipir.gr/PersonalPages/papageorgas/download
/2/shmeiwseis/pcb_fuse_translation_3.pdf 

 
 
 
 

 
Τυπωµένη πλακέτα κυκλωµάτων πολλαπλών επιπέδων (Multi-layer 

PCB) 
 

 

   Όπως φαίνεται και από την ονοµασία οι πλακέτες αυτές έχουν πολλά 

επίπεδα µε αγώγιµες διαδροµές, δύο από τις οποίες βρίσκονται στις 

επιφάνειες της πλακέτας. Τα άλλα επίπεδα βρίσκονται μεταξύ των δύο 

εξωτερικών επιπέδων  και η κατασκευή τους επιτυγχάνεται µε ένα αριθµό 

αγώγιµων διαδροµών που συνδυάζονται µε µονωτικά επίπεδα. Οι συνδέσεις 

αυτών των αγώγιµων διαδροµών υλοποιείται µε «περάσµατα» µεταξύ των 

επιπέδων “through via” είτε µε κρυφές διαδρομές «buried via». Η διαφορά τους 

είναι ότι ένα πέρασµα µεταξύ των επιπέδων απλά διαπερνά την πλακέτα ενώ 

ένα κρυφό πέρασµα συνδέει εσωτερικές αγώγιµες διαδροµές. 
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Σχήμα 3:Τυπωµένη πλακέτα κυκλωµάτων πολλαπλών επιπέδων (Multi-layer 
PCB) 

Πηγή:http://www.electronics.teipir.gr/PersonalPages/papageorgas/download/2/s
hmeiwseis/pcb_fuse_translation_3.pdf 

 
 
 
 

4.3  Παραλλαγές σχεδίασης PCBs 
 

   Οι παραλλαγές στην σχεδίαση των PCBs που ακολουθούν σύµφωνα µε τα 

παραπάνω είναι οι ακόλουθες: 

 

-Κυκλώµατα µε οπές µεταξύ των επιπέδων (Through-hole circuits)  

-Κυκλώµατα µε εξαρτήµατα επιφανειακής στήριξης (Surface mounted circuits)  
 

 
 

Κυκλώµατα µε οπές µεταξύ των επιπέδων (Through-hole circuits) 
 

   Τα εξαρτήµατα αυτού του τύπου έχουν ακροδέκτες οι οποίοι τοποθετούνται 

σε οπές στο PCB,  γι’αυτό και χρησιµοποιείται  ο όρος “ τεχνολογία οπών 

µεταξύ των επιπέδων”. Η  αγωγιµότητα εξασφαλίζεται µε την κόλληση των 

ακροδεκτών στα δύο επίπεδα της πλακέτας. 
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Σχήμα 4:Through-hole Technology 
 
 

Τεχνολογία επιφανειακής στήριξης (Surface Mount Technology-SMT) 
 

  Η τεχνολογία επιφανειακής στήριξης είναι στην ουσία µια τυπωµένη πλακέτα 

κυκλωµάτων που πάνω της στηρίζονται τα εξαρτήματα όπως στην TH µε την 

διαφορά ότι σ’ αυτή την τεχνολογία οι ακροδέκτες δεν διαπερνούν την πλακέτα 

αφού στα εξαρτήµατα αυτού του τύπου δεν υπάρχουν ακροδέκτες µε ακίδες. 

Τα εξαρτήµατα τοποθετούνται έτσι ώστε οι ακροδέκτες να κολλούνται στις 

αντίστοιχες αγώγιµες νησίδες. 

 

 

 

 

 

 

 
 

 
Σχήμα 5:Surface Mount Technology 

Πηγή:http://www.electronics.teipir.gr/PersonalPages/papageorgas/download/2/s
hmeiwseis/pcb_fuse_translation_3.pdf 
 

 

http://www.electronics.teipir.gr/PersonalPages/papageorgas/download/2/shmeiwseis/pcb_fuse_translation_3.pdf
http://www.electronics.teipir.gr/PersonalPages/papageorgas/download/2/shmeiwseis/pcb_fuse_translation_3.pdf
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ΚΕΦΑΛΑΙΟ 5 
 
Γνωριμία με OrCad PSpice 

 
Τι είναι το ORCAD-PSPICE lite edition και γιατί χρησιμοποιείται ευρέως 
 
   Το Orcad-PSpice είναι ένα ευρέως διαδεδομένο και διεθνώς αποδεκτό 

πρόγραμμα, το οποίο χρησιμοποιείται για την Προσομοίωση της συμπεριφοράς 

των κυκλωμάτων σε επίπεδο μοντέλων. Με τον τρόπο αυτό επιτυγχάνεται η 

ανάλυση πολύπλοκων κυκλωμάτων σε πολύ σύντομο χρονικό διάστημα, 

οδηγώντας σε αποτελέσματα πολύ ακριβή, πάντα μέσα στα πλαίσια των 

προσεγγίσεων. Από τη στιγμή που ο σχεδιασμός ενός κυκλώματος έχει γίνει σε 

πρώτη προσπάθεια με κλασσικές διαδικασίες, η επαλήθευση της λειτουργίας του 

κυκλώματος, μπορεί να γίνει με τη χρήση ηλεκτρονικού υπολογιστή, μέσω του 

προγράμματος ανάλυσης PSpice. Επαναληπτικές τροποποιήσεις και αναλύσεις 

του κυκλώματος μπορεί να οδηγήσουν γρήγορα και εύκολα στον τελικό 

σχεδιασμό. Έτσι πραγματοποιείται ο σχεδιασμός κυκλωμάτων, μέσω 

προγραμμάτων ανάλυσης. 

   Η εξοικείωση με τα προγράμματα ανάλυσης κυκλωμάτων, 

συμπεριλαμβανομένου και του προγράμματος PSpice, δημιουργεί την 

αυτοπεποίθηση για τη μελέτη πολύπλοκων κυκλωμάτων και συστημάτων. 

Ταυτόχρονα παρέχει τη βεβαιότητα ότι, τα αποτελέσματα Προσομοίωσης των 

κυκλωμάτων θα βρίσκονται κοντά στα προσδοκώμενα αποτελέσματα στην πράξη. 

Ένας επιπλέον λόγος που συνηγορεί στο σχεδιασμό κυκλωμάτων με τη χρήση 

προγραμμάτων ανάλυσης είναι, ότι ο σχεδιασμός στον πάγκο δεν παρέχει στο 

χρήστη τα διαθέσιμα στοιχεία ως διακριτά, με αποτέλεσμα στη σημερινή εποχή να 

είναι αδιανόητο να προχωρήσει κανείς στο σχεδιασμό ηλεκτρονικών κυκλωμάτων 

χωρίς τη χρήση υπολογιστών. 
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   Έτσι λοιπόν το Orcad PSpice Lite Edition, αλλά και κάθε έκδοση του 

προγράμματος Spice, έχει ως σκοπό την Προσομοίωση κυκλωμάτων για μη 

γραμμικές dc, μη γραμμικές transient και γραμμικές ac αναλύσεις. Τα κυκλώματα 

μπορεί να περιλαμβάνουν αντιστάσεις, πυκνωτές, πηνία, αμοιβαίους επαγωγείς, 

ανεξάρτητες και εξαρτημένες πηγές ρεύματος και τάσεως, όπως επίσης και 

ημιαγωγά στοιχεία, λόγου χάρη διόδους και τρανζίστορ. 
 
 

Περιβάλλον Εργασίας (Graphical User Interface) 
 

 
   Κατόπιν της εκκίνησης του προγράμματος (Capture.exe) εισερχόμαστε στο 

περιβάλλον αυτού. Για την ακρίβεια πρόκειται για ένα περιβάλλον εισαγωγής στο 

οποίο δεν είναι άμεσα δυνατή οποιαδήποτε ενέργεια – λειτουργία έχει σχέση με 

την Προσομοίωση κυκλωμάτων. Σε αυτό το στάδιο είναι εφικτή μόνο η διεξαγωγή 

ρυθμίσεων που αφορούν το περιβάλλον εργασίας (ρυθμίσεις διαστάσεων της 
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σελίδας σχεδίασης, χρωματικών επιλογών, γραμματοσειρών, επιλογών 

εστίασης, κτλ.), η εκκίνηση νέων ή η το άνοιγμα παλαιών εργασιών (projects), η 

εκτύπωση (και οι ρυθμίσεις αυτής) φύλλων εργασιών κτλ. Αυτό αποδίδεται στην 

εικόνα που ακολουθεί: 

   Τα στοιχεία που χαρακτηρίζουν το εισαγωγικό περιβάλλον του προγράμματος 

όπως φαίνεται και από την παραπάνω εικόνα είναι ένα menu επιλογών, κάποια 

button συντόμευσης (γραμμή εργαλείων - toolbar), τη γραμμή κατάστασης 

(status bar), και ένα επιπλέον πλαίσιο διαλόγου (Session Log), το οποίο και 

αποτελεί το τρέχον ημερολόγιο του προγράμματος. 

 
 
 
 
Menu Επιλογών 
 
 
   Από το menu επιλογών διεξάγονται όλες οι λειτουργίες και οι ρυθμίσεις του 

προγράμματος είτε αυτές σχετίζονται είτε με την διαχείριση και την προσπέλαση 

των αρχείων ενός project, είτε με τον καθορισμό κάποιων χαρακτηριστικών του 

προγράμματος, είτε τέλος, με τις διάφορες διαδικασίες Προσομοίωσης και 

προβολής των αποτελεσμάτων. Αποτελεί δηλαδή τον κύριο και βασικό τρόπο 

χειρισμού του προγράμματος από το χρήστη. 

   Συγκεκριμένα, κατά την εκκίνηση του προγράμματος, παρατηρούμε την 

ύπαρξη των πεδίων: File, View, Edit, Options, Window και Help. Υπάρχουν 

και άλλα πεδία τα οποία δεν εμφανίζονται στην παρούσα φάση. Αυτά κυρίως 

περιέχουν τις επιλογές σχεδίασης και Προσομοίωσης οι οποίες αποκτούν 

ενδιαφέρον στη συνέχεια. Τα κυριότερα από αυτά τα πεδία περιγράφονται 

παρακάτω: 
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•  File 
   Το πεδίο αυτό σχετίζεται με μια σειρά υπό-επιλογών που αφορούν τη 

διαχείριση και την προσπέλαση των αρχείων Προσομοίωσης Με την υπό-

επιλογή “Import” είναι δυνατή η εισαγωγή δεδομένων για Προσομοίωση υπό 

μορφή σχηματικού διαγράμματος από συμβατά προγράμματα. Απαραίτητη 

προϋπόθεση είναι η ύπαρξη κατάλληλου output file από το έτερο πρόγραμμα. 

 

•  Edit 
   Σε αυτό το πεδίο, γενικά, είναι δυνατή η επεξεργασία των διαφόρων τμημάτων 

και προ-επιλεγμένων αντικειμένων του project. Πρέπει επίσης να επισημανθεί το 

γεγονός ότι μέσω της επιλογής PSpice Stimulus καθίσταται δυνατή η ρύθμιση 

των ιδιοτήτων των AC Stimulus πηγών κατά τη διαδικασία δημιουργίας 

σχηματικού διαγράμματος στο αντίστοιχο παράθυρο (Schematic Editor). 

 

•  View 
   Σε αυτό το πεδίο διεξάγονται οι ρυθμίσεις προβολής του περιβάλλοντος 

εργασίας. Κατά την εκκίνηση του προγράμματος είναι δυνατή μόνο η ρύθμιση 

εμφάνισης/απόκρυψης της γραμμής εργαλείων (toolbar). Από το πεδίο αυτό 

επίσης, παρέχονται επιλογές για την προβολή των διαφόρων αποτελεσμάτων 

Προσομοίωσης καθώς και των output files. 

 
•  Options 

   Το πεδίο αυτό αφορά τις διάφορες ρυθμίσεις και επιλογές που σχετίζονται είτε 

με το περιβάλλον εργασίας, είτε με κάποιο προ-επιλεγμένο αντικείμενο. 
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•  Window 
   Το πεδίο αυτό περιέχει ρυθμίσεις που κατά κανόνα αφορούν την προβολή 

των διαφόρων παραθύρων του προγράμματος. Μια ολοκληρωμένη διαδικασία 

Προσομοίωσης περιλαμβάνει πολλά στάδια εργασίας και επεξεργασίας 

αποτελεσμάτων. Ξεκινώντας από τη δημιουργία του σχηματικού διαγράμματος 

και τη δημιουργία αρχείου Bias Point, μέχρι την AC Transient και Sweep 

Ανάλυση. 

 
•  Tools 

   Σε αυτό το πεδίο περιέχονται χρήσιμες λειτουργίες του συστήματος. Με την 

επιλογή Bill of Materials δημιουργείται αυτόματα από το πρόγραμμα η λίστα 

των υλικών που απαιτούνται για την υλοποίηση της σχεδίασης. Με την 

επιλογή Create Netlist δημιουργείται το κατάλληλο αρχείο διασύνδεσης των 

πληροφοριών του σχηματικού διαγράμματος (Capture) με το συμβατό 

πακέτο σχεδίασης τυπωμένων κυκλωμάτων (OrCAD Layout) ή άλλα 

συμβατά πακέτα δημιουργίας PCB, ενώ με την επιλογή Design Rules Check 

ελέγχεται η ορθότητα της σχεδίασης. 

 

•  Pspice 
   Στο παρών πεδίο διεξάγονται οι ρυθμίσεις, η εκτέλεση και η προβολή των 

αποτελεσμάτων μιας Προσομοίωσης. Επίσης με την επιλογή “Create 

Netlist”δημιουργείται το κατάλληλο αρχείο διασύνδεσης των πληροφοριών του 

σχηματικού διαγράμματος (Capture) με το συμβατό πακέτο σχεδίασης 

τυπωμένων κυκλωμάτων (OrCAD Layout) ενώ με την επιλογή “View Netlist” 

είναι δυνατή η προβολή του αρχείου αυτού. 
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•  Place 
Το πεδίο αυτό εμφανίζεται μόνο στο σχηματικό συντάκτη (Schematic Editor) 

και περιέχει τις επιλογές των στοιχείων για τη δημιουργία του σχηματικού 

διαγράμματος. Μέσω αυτών καθίσταται δυνατή η τοποθέτηση των διαφόρων 

εξαρτημάτων - στοιχείων και η καλωδίωση τους στο σχηματικό διάγραμμα. 

 
 

   •  Simulation 
Το πεδίο αυτό εμφανίζεται μόνο στα παράθυρα απεικόνισης των 

αποτελεσμάτων Προσομοίωσης. Από εδώ είναι εφικτές οι βασικές επιλογές και 

λειτουργίες της Προσομοίωσης. Μέσω κατάλληλων ρυθμίσεων είναι δυνατή η 

επιλογή του τύπου της Προσομοίωσης, η επιλογή του χρονικού διαστήματος 

καθώς και λειτουργίες ελέγχου όπως η εκτέλεση, η παύση και η διακοπή αυτής. 

 

    •  Trace 
Το πεδίο αυτό εμφανίζεται μόνο στα παράθυρα απεικόνισης των 

αποτελεσμάτων Προσομοίωσης. Από εδώ καθίσταται δυνατή η επιλογή των 

διαφόρων προς απεικόνιση μεγεθών - στοιχείων (τάσεις, ρεύματα) όπως και η 

ενεργοποίηση cursor για την εύκολη και ακριβή προβολή των τιμών στα διάφορα 

σημεία των κυματομορφών. 

    Επίσης παρέχεται η δυνατότητα προβολής - μετασχηματισμού των     

αποτελεσμάτων από το πεδίο του χρόνου στο πεδίο της συχνότητας (Fourier) και 

αντίστροφα. 
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   • Plot 

 
   Το πεδίο αυτό ενεργοποιείται μόνο στα παράθυρα απεικόνισης των 

αποτελεσμάτων Προσομοίωσης(OrCAD PSpice A/D). Μέσω των επιλογών του 

είναι δυνατή η κατ’ επιλογή γραφική απεικόνιση παραστάσεων με επιλεγμένες 

εξαρτημένες και ανεξάρτητες μεταβλητές (y=F(x)). Με άλλα λόγια είναι εφικτή η 

επιλογή των μεγεθών στους άξονες Χ και Y. Αυτό είναι ιδιαίτερα σημαντικό για 

περιπτώσεις όπου απαιτείται η απεικόνιση του σήματος εξόδου συναρτήσει του 

σήματος εισόδου όπως συμβαίνει για τις περιπτώσεις ελέγχου της γραμμικότητας 

των κυκλωμάτων. Επίσης, από την επιλογή αυτή είναι δυνατή η ρύθμιση της 

κλίμακας των αξόνων όπως και η προσθήκη ετικετών, γραμμών και γραφικών 

σχεδίων επί της γραφικής απεικόνισης των αποτελεσμάτων. 

 
     • Help 

 
   Το πεδίο αυτό αφορά τη χρήση βοήθειας σχετικά με τη λειτουργία και τις 

πιθανές παραμέτρους του προγράμματος. Η επιλογή αυτή αποτελεί ένα πολύ 

σημαντικό στοιχείο, καθώς απευθύνεται σε όλους τους χρήστες (αρχάριους και 

μη) ανάλογα με το είδος και τη φυσιολογία του προβλήματος που συνάντησαν. 

 
Γραμμή Εργαλείων (toolbar) 

 
   Η γραμμή Εργαλείων (Toolbar) στην ουσία απαρτίζεται από button που 

αποτελούν τις συντομεύσεις των πιο κοινών λειτουργιών του προγράμματος. Ο 

σκοπός της γραμμής εργαλείων (Toolbar) είναι να διευκολύνει και μόνο το χρήστη 

καθώς κάθε πιθανή λειτουργία που περιέχεται στη γραμμή εργαλείων. 
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Δημιουργία Εργασίας-Project 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Σχήμα 6: Παράθυρο εισαγωγής ονόματος της εργασίας καθώς και του χώρου 

αποθήκευσης αυτής ζητείται στο χρήστη να δώσει ένα όνομα στο σχηματικό 
καθώς και το μονοπάτι αποθήκευσης. 
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   Προκειμένου να γίνει χρήση του προγράμματος (και των δυνατοτήτων που 

αυτό παρέχει) για την Προσομοίωση κάποιου ηλεκτρικού ή ηλεκτρονικού 

κυκλώματος απαιτείται η δημιουργία ενός νέου project στο πρόγραμμα. Ως 

project ουσιαστικά ορίζεται το σύνολο των αρχείων που φέρουν το ίδιο όνομα (το 

όνομα που έχει προσδώσει ο χρήστης στο project) και περιέχουν τις διάφορες 

σχεδιαστικές πληροφορίες του συγκεκριμένου ηλεκτρικού – ηλεκτρονικού 

κυκλώματος ή ακόμα και τα αποτελέσματα Προσομοίωσης αν αυτή έχει ήδη 

πραγματοποιηθεί. Δηλαδή, τα αρχεία του σχηματικού διαγράμματος, τα αρχεία 

Προσομοίωσης κτλ. ενός κυκλώματος απαρτίζουν ένα project. 

    

   Το πλήθος των αρχείων αυτών δεν είναι συγκεκριμένο αλλά μπορεί να 

μεταβάλλεται από project σε project ανάλογα με το μέγεθος (αριθμό) και το είδος  

των αναλύσεων – Προσομοιώσεων που έχουν διεξαχθεί. Για την δημιουργία ενός 

νέου project στο πρόγραμμα (PSpice 9.1 - Student Version) επιλέγουμε 

διαδοχικά: 

 

File → New → Project 

 

   Στη συνέχεια εμφανίζεται ένα πλαίσιο διαλόγου (New Project). Σε αυτό είναι 

ορατή η δυνατότητα δημιουργίας project μέσω των επιλογών: Analog or Mixed 
A/D, PC Board Wizard, Programmable Logic Wizard και Schematic. Κάθε 

επιλογή αποσκοπεί σε συγκεκριμένη χρήση των δυνατοτήτων του 

προγράμματος ανάλογα με τις εκάστοτε απαιτήσεις. Έτσι έχουμε: 

 

• Analog or Mixed A/D 
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   Η επιλογή αυτή αποσκοπεί σε χρήση του παραγόμενου σχηματικού 

διαγράμματος για Προσομοίωση αναλογικών ή υβριδικών (ψηφιακών και 

αναλογικών) ηλεκτρονικών διατάξεων. Για το σκοπό αυτό, εκτός από τα στοιχεία 

των σχηματικών σχεδίων των βιβλιοθηκών του προγράμματος (OrCAD PSpice), 

γίνονται διαθέσιμα και δεδομένα που αφορούν την ηλεκτρική συμπεριφορά των 

εξαρτημάτων. 

 

•    PC Board Wizard 

 
   Με την επιλογή αυτή παρέχεται η δυνατότητα περαιτέρω αξιοποίησης του 

σχηματικού διαγράμματος για την δημιουργία μακετών τυπωμένων κυκλωμάτων 

(PCB - Printed Circuit Board). Αυτό ωστόσο είναι εφικτό μόνο με τη χρήση ενός 

κατάλληλου συμβατού προγράμματος, του “OrCAD Layout”. Οι πληροφορίες 

διασύνδεσης των εξαρτημάτων μεταφέρονται από το σχηματικό διάγραμμα 

(Capture) στο πρόγραμμα “OrCAD Layout” με τη βοήθεια ενός ειδικού αρχείου 

(netlist), όπου σε συνδυασμό με τα “footprints” των διαφόρων εξαρτημάτων 

χρησιμοποιούνται για να αποδώσουν τη μακέτα του τυπωμένου κυκλώματος 

(PCB). 

  

•    Programmable Logic Wizard 

 
   Με την επιλογή αυτή παρέχεται η δυνατότητα σχεδίασης και υλοποίησης 

διατάξεων που περιέχουν προγραμματιζόμενες λογικές διατάξεις (CPLD, 

FPGA). Αυτό όμως, προϋποθέτει και την συμπληρωματική χρήση ενός  

κατάλληλου συμβατού προγράμματος, του “OrCAD Express”. 
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• Schematic 
 

   Με την ενεργοποίηση της επιλογής αυτής καθίσταται δυνατή η δημιουργία 

μόνο σχηματικών διαγραμμάτων των κυκλωμάτων χωρίς καμία μετέπειτα 

δυνατότητα επεξεργασίας. Αυτό συμβαίνει γιατί έτσι γίνονται διαθέσιμα 

(φορτώνονται) στο πρόγραμμα μόνο τα δεδομένα των βιβλιοθηκών που 

σχετίζονται με τα σχηματικά σύμβολα των στοιχείων και όχι αυτά που 

περιέχουν την ηλεκτρική συμπεριφορά των χρησιμοποιούμενων εξαρτημάτων. 

 

   Κατά τη δημιουργία ενός νέου project (στο πλαίσιο διαλόγου “new project”), 

εκτός από το πεδίο που αφορά τις σχεδιαστικές επιλογές, εμφανίζονται και 

άλλα πεδία που αφορούν την καταχώρηση και αποθήκευση των 

δημιουργούμενων  αρχείων. Έτσι, στο πεδίο “name” δίνουμε το όνομα του 

Project, ενώ στο πεδίο “Location” με τη βοήθεια του File Manager (πλήκτρο 

Browse) δίνουμε τον προορισμό “path” του φακέλου στον οποίο θα περιέχονται 

τα διάφορα αρχεία του εν λόγω project. 

   Κάνοντας κλικ στην επιλογή Analog or Mixed A/D και εν συνεχεία πατώντας 

ΟΚ εμφανίζεται το παράθυρο του σχήματος 7, όπου εκεί επιλέγοντας την 

ένδειξη Create a blank project παρουσιάζεται το κεντρικό παράθυρο του 

Capture Cis (Σχήμα 8). Βέβαια το κεντρικό παράθυρο δύναται να παρουσιαστεί 

με απευθείας κλικάρισμα στην επιλογή Schematic του σχήματος 1. Όταν όμως 

πρόκειται το σχεδιαζόμενο κύκλωμα να χρησιμοποιηθεί για Προσομοίωση τότε 

επιλέγεται απαραιτήτως η πρώτη διαδικασία. 

   Σε αυτό το σημείο πρέπει να τονίσουμε το γεγονός ότι δεν είναι δυνατή 

οποιαδήποτε μετέπειτα αλλαγή του προορισμού αποθήκευσης και ότι κάθε 

εκ’ νέου μεταβολή των στοιχείων - δεδομένων των αρχείων του project (ή 

ακόμα και η προσθήκη νέων αρχείων ως αποτελέσματα περαιτέρω 

επεξεργασίας) θα γίνονται σε αυτόν τον προορισμό (path). (Η μόνη 

δυνατότητα μεταβολής του προορισμού αποθήκευσης ενός project είναι η  
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μεταφορά του συνόλου των αρχείων του σε άλλο προορισμό – φάκελο μέσα 

από το λειτουργικό σύστημα και εφ’ όσον κανένα αρχείο του project αυτού δεν                     

χρησιμοποιείται τη δεδομένη χρονική στιγμή από τον Η/Υ.) 

 
 
 
 
 
 
 
 
 
 
 
 
 

Σχήμα 7: Create PSpice Project 
 

 
Σχήμα 8:  Κεντρικό παράθυρο του σχηματικού. 
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  Δεξιά της οθόνης υπάρχει μία μπάρα όπου βρίσκονται όλες σχεδόν οι 

λειτουργίες του σχηματικού. H μπάρα αυτή αποτελείται από 

συγκεκριμένα πλήκτρα, τα οποία φαίνονται καλύτερα στο σχήμα 9. Το 

πρώτο πλήκτρο είναι ένα βελάκι, το οποίο πρέπει να είναι πατημένο 

όταν ο χρήστης δουλεύει στον κεντρικό χώρο του σχηματικού. Όταν 

αυτός θελήσει να εισάγει στοιχείο τουκυκλώματος πατάει το δεύτερο 

κουμπί. Τότε στο κέντρο της οθόνης εμφανίζεται ένα τετράγωνο όπως 

αυτό του σχήματος 5.  Το τρίτο κατά σειράπλήκτρο είναι για την 

καλωδίωση. Όταν είναι πατημένο μπορεί ο χρήστης να ενώσει με 

καλώδιο τα στοιχειά που ήδη έχει τοποθετήσει στο χώρο του 

σχηματικού. 

   Με τα πλήκτρα PWR και GND γίνεται η δήλωση της ύπαρξης τροφοδοσίας 

και γείωσης. Τα έξι τελευταία πλήκτρα της δεξιάς αυτής μπάρας 

χρησιμοποιούνται για τη σχεδίαση σχημάτων και την εισαγωγή τίτλου 

(τελευταίο κουμπί). 

 
 
 
 
 

Σχήμα 9: Δεξιά μπάρα του κεντρικού παραθύρου του Capture Cis. 



ΣΥΓΚΡΙΣΗ  ΔΥΝΑΤΟΤΗΤΩΝ ΠΡΟΓΡΑΜΜΑΤΩΝ ΠΡΟΣΟΜΟΙΩΣΗΣ ΤΥΠΩΜΕΝΩΝ 
ΠΛΑΚΕΤΤΩΝ (PCB) 
 

54 
Αγγελίδης Γεώργιος , Αρβανίτης Νικήτας 

 

 
 
 
Επιλογή και εισαγωγή στοιχείου του κυκλώματος 

 
   Όπως αναφέρθηκε και πιο πάνω με την επιλογή του δεύτερου πλήκτρου της 
δεξιάς μπάρας , εμφανίζεται στην οθόνη το παράθυρο του σχήματος 10. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Σχήμα 10: Εύρεση στοιχείου. 
 
   Στο χώρο αυτό εμφανίζονται τρία μικρότερα τετράγωνα. Στο κάτω αριστερά 

είναι η λίστα με τις υπάρχουσες βιβλιοθήκες. Με το πρώτο άνοιγμα του 

παραθύρου δεν υπάρχει καμία διαθέσιμη βιβλιοθήκη στο χρήστη, ενώ αυτές 

εμφανίζονται μέσω της επιλογής Add Library Εμφανίζεται το παράθυρο που 

απεικονίζεται στην Εικόνα από κάτω.  

 
 
 
 



ΣΥΓΚΡΙΣΗ  ΔΥΝΑΤΟΤΗΤΩΝ ΠΡΟΓΡΑΜΜΑΤΩΝ ΠΡΟΣΟΜΟΙΩΣΗΣ ΤΥΠΩΜΕΝΩΝ 
ΠΛΑΚΕΤΤΩΝ (PCB) 
 

55 
Αγγελίδης Γεώργιος , Αρβανίτης Νικήτας 

 

 
 

 
 

  
  Με την ενεργοποίηση της ένδειξης Remove Library δίνεται η δυνατότητα 

μεταφοράς βιβλιοθηκών από το δεξί τετράγωνο του παραθύρου σε άλλο χώρο 

του προγράμματος. 

   Στο κεντρικό τετράγωνο υπάρχουν τα στοιχεία που περιέχει η βιβλιοθήκη που 

επέλεξε ο χρήστης, ενώ στο κάτω δεξιά τετράγωνο εμφανίζεται το αντίστοιχο 

σχηματικό κάθε στοιχείου. Με την εύρεση του επιθυμητού στοιχείου και 

επιλέγοντας την ένδειξη OK μεταφέρεται το στοιχείο στο σχηματικό. 

   Με το Part Search μπορεί ο χρήστης αν γνωρίζει τον κωδικό ενός στοιχείου 

να το αναζητήσει σε όλες τις διαθέσιμες βιβλιοθήκες του προγράμματος. Με το 

πάτημα του πλήκτρου εμφανίζεται στην οθόνη το παράθυρο του σχήματος 11. 

Στο πεδίο Part Name ζητείται από το χρήστη να εισάγει το κωδικό όνομα του 

στοιχείου που αναζητά. Η διαδικασία εύρεσης του στοιχείου ενεργοποιείται με 

την επιλογή Begin Search. Αν το στοιχείο είναι διαθέσιμο τότε κάτω από την 

ένδειξη Libraries παρουσιάζεται το όνομα της βιβλιοθήκης που το διαθέτει. Με 

διπλό δεξί κλικ πάνω στο όνομα της βιβλιοθήκης γίνεται αυτόματα η μεταφορά 

του στοιχείου στο χώρο του σχηματικού.  
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  Τέλος με την επιλογή Browse, δίδεται η δυνατότητα αναζήτησης σε 

διαφορετικό χώρο στον υπολογιστή, όπου ενδεχομένως να υπάρχουν 

αποθηκευμένες βιβλιοθήκες. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Σχήμα 11: Αναζήτηση στοιχείου μέσω του κωδικού ονόματός του. 
 
   Όλα τα εξαρτήματα που διαθέτει το OrCAD Capture είναι, οργανωμένα σε 

κατηγορίες, τις βιβλιοθήκες. Κάθε βιβλιοθήκη περιέχει εξαρτήματα συγκεκριμένου 

τύπου, κάθε ένα από τα οποία χαρακτηρίζεται από συγκεκριμένες προδιαγραφές, 

οι οποίες είναι απαραίτητες για να γίνει η σωστή προσομοίωση του εκάστοτε 

κυκλώματος. 

   Στοιχεία όπως πυκνωτές και αντιστάσεις εισέρχονται στο σχηματικό με 

προκαθορισμένες τιμές, π.χ οι αντιστάσεις εισέρχονται με τιμή 1ΚΩ, οι 

πυκνωτές με τιμή 1n κ.ο.κ. Για να αλλάξει ο χρήστης την τιμή αυτή, κάνει διπλό 

κλικ πάνω στην αρχική τιμή του στοιχείου, οπότε εμφανίζεται το κάτωθι 

παράθυρο (σχήμα 12). Κάνοντας κλικ στο βέλος που υπάρχει δεξιά της 

επιλογής Default, μπορεί ο χρήστης του προγράμματος να αλλάξει το χρώμα  
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της τιμής του στοιχείου. Ενώ με την ένδειξη Change, ο χρήστης ορίζει άλλη 
γραμματοσειρά και διαφορετικό μέγεθος, στην τιμή του στοιχείου.     
 
 
   Πρέπει να αναφερθεί ότι το ίδιο παράθυρο θα εμφανιστεί σε περίπτωση που ο 

χρήστης επιθυμεί να αλλάξει τον κωδικό του στοιχείου, δηλαδή σε περίπτωση 

που επιδιώκει μια αντίσταση R1 να την μετονομάσει σε αντίσταση R5. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Σχήμα 12: Αλλαγή τιμών εξαρτήματος 
 
 
Ορισμός ανάλυσης 
 
   Αφού ο χρήστης πραγματοποίησε όλη την διαδικασία του προηγούμενου 

βήματος, είναι σε θέση τώρα να κάνει Προσομοίωση του κυκλώματος. Αυτό 

που επιβάλλεται να κάνει σε πρώτη φάση είναι να ορίσει τι είδους 

Προσομοίωση θέλει να πραγματοποιήσει. Έτσι από το κεντρικό μενού 

επιλέγει PSpice και εν συνεχεία Edit Simulation Profile και αυτόματα 

οδηγείται στο παράθυρο του σχήματος 13. 
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   Eίναι το παράθυρο που ο χρήστης θα ορίσει τον τύπο της ανάλυσης που 

επιθυμεί να πραγματοποιηθεί. Το παράθυρο αυτό βέβαια παρέχει και άλλες 

σημαντικές ρυθμίσεις,. Έτσι μέσω της επιλογής Probe Window-> Last Plot, 
δύναται ο χρήστης να κρατήσει προηγούμενες γραφικές παραστάσεις. Μετά 

από αυτή τη μικρή παρέμβαση θα γίνει επεξήγηση των δυνατοτήτων αυτού 

του παραθύρου γύρω από τους τύπους ανάλυσης που προσφέρει. Έτσι 

μέσα από την επιλογή Analysis Type προσφέρονται οι εξής επιλογές : 

 

 
Σχήμα 13: Επιλογή τρόπου Προσομοίωσης 
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• Bias Point 
       όπου υπολογίζει τις τιμές των ρευμάτων, των τάσεων και της ισχύος 

σε όλους τους κόμβους και τα αποτελέσματα τα αποθηκεύει σε αρχείο. Η 

διαδικασία αυτή δεν ενεργοποιεί το κεντρικό παράθυρο Προσομοίωσης του 

PSpice. 

 

• Time Domain 
                                 απ’όπου ο χρήστης μπορεί να πάρει γραφικές παραστάσεις 

συναρτήσει του χρόνου. Εδώ πρέπει να ορίσει τον χρόνο Προσομοίωσης, τη 

χρονική καθυστέρηση εκκίνησης του σήματος, όπως επίσης και το βήμα 

σάρωσης. 

 

• AC Analysis 
                  απ’όπου ο χρήστης μπορεί να πάρει γραφήματα σε συνάρτηση με 

τη συχνότητα. Για να πάρει το συγκεκριμένο γράφημα, πρέπει να ορίσει 

αρχική και τελική συχνότητα σάρωσης, όπως επίσης και το βήμα σάρωσης το 

οποίο θα είναι ορισμένο κατά οκτάδες ή κατά δεκάδες. Επίσης υπάρχει 

δυνατότητα ο άξονας της συνάρτησης να είναι σε γραμμική ή λογαριθμική 

μορφή. Η εισαγωγή των αποτελεσμάτων μπορεί να γίνει σε ξεχωριστό 

αρχείο. 

 
• DC/Sweep Analysis 

                   όπου ο χρήστης μπορεί να κάνει και παραμετρική ανάλυση 

αρκεί να δηλώσει την μεταβλητή της ανάλυσης, την αρχική και τελική τιμή που 

θέλει να λάβει καθώς και το βήμα μεταβολής. Ακόμη μπορεί να δηλώσει αν ο 

άξονας των τιμών θέλει να έχει γραμμική ή λογαριθμική μορφή. 
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Απεικόνιση αποτελεσμάτων στην οθόνη 
 

   Η απεικόνιση αποτελεσμάτων στην οθόνη, είναι τα αποτελέσματα της 

Προσομοίωσης του κυκλώματος, η οποία ενεργοποιείται με την επιλογή Run 
από το κεντρικό menu ή από το μπλε βελάκι από τη γραμμή εργαλείων του 

βασικού menu ή ακόμα και από το πληκτρολόγιο μέσω του κουμπιού F11. 

Αυτόματα ανοίγει και το παράθυρο του PSpice το οποίο έχει τη μορφή του 

σχήματος 14. Η αριστερή του μπάρα βοηθάει το χρήστη να επιστρέψει στο 

αρχείο εισόδου ή να προχωρήσει στο αρχείο εξόδου, ενώ η μπάρα κάτω 

από το παράθυρο δείχνει την ολοκλήρωση της Προσομοίωσης, εφόσον 

βέβαια παρουσιαστεί το ποσοστό 100%, που φαίνεται ακολούθως. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Σχήμα 14: Το παράθυρο του χώρου Προσομοίωσης. 
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   Από το κεντρικό menu επιλέγεται Trace και κατόπιν Add Trace, οπότε και 

εμφανίζεται το παράθυρο του σχήματος 15. Παρατηρούμε ότι το παράθυρο 

χωρίζεται σε δύο επιμέρους παραθυράκια. Στο αριστερό παραθυράκι είναι 

όλες οι μεταβλητές του κυκλώματος, όπως τάσεις, ρεύματα, κ.α. Στη μέση των 

δύο παραθύρων είναι γραμμένος ο συνολικός αριθμός των μεταβλητών, με 

ταυτόχρονη ομαδοποίηση τους. Ο χρήστης έχει τη δυνατότητα κάνοντας κλικ 

δίπλα από την λέξη Currents, να εξαφανίσει από τη λίστα τα ρεύματα, δε 

μπορεί όμως να εξαφανίσει ορισμένα μόνο ρεύματα. Στο δεξί παραθυράκι και 

στην επιλογή Analog Operators and Functions υπάρχει μία λίστα από 

μαθηματικές συναρτήσεις. Επιλέγοντας πρώτα μια συνάρτηση από το δεξί 

παράθυρο και εν συνεχεία μία ή περισσότερες μεταβλητές από το αριστερό 

παράθυρο και κάνοντας κλικ στο ΟΚ, εμφανίζεται η γραφική παράσταση στο 

κεντρικό παράθυρο του PSpice. 

 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Σχήμα 15: Παράθυρο επιλογής μεταβλητών και συναρτήσεων
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   O κάθετος άξονας έχει ως μεταβλητή αυτή που όρισε ο χρήστης, ενώ ο 

οριζόντιος άξονας είναι βαθμολογημένος στις μονάδες της μεταβλητής που 

σαρώνεται, σύμφωνα πάντα με την εντολή ανάλυσης. Δίνεται βέβαια στο 

χρήστη η δυνατότητα αλλαγής της μεταβλητής του οριζόντιου άξονα, αλλά και 

του καθέτου μέσω της επιλογής Plot από το κεντρικό menu Pspice και 

κατόπιν Axis Settings και User Defined, οπότε εμφανίζεται το παράθυρο του 

σχήματος 16. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
.  

 
 
 
 
 
 
 
 

Σχήμα 16: Προσαρμογή κλίμακας αξόνων. 
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   Τέλος παρέχεται δυνατότητα επιλογής γραμμικής ή λογαριθμικής κλίμακας 

για τον κάθε άξονα. Σε περίπτωση που ο χρήστης επιθυμεί να έχει δύο 

γραφικές διαφορετικών μεταβλητών στην ίδια γραφική παράσταση, μπορεί να 

το πραγματοποιήσει επιλέγοντας Plot από το κεντρικό menu και εν συνεχεία 

Add Y. Μια εικόνα του γραφικού σε συνδυασμό με δύο κάθετους άξονες που 

αντιπροσωπεύουν διαφορετικές μεταβλητές, παρουσιάζεται αμέσως 

παρακάτω.(σχήμα 17). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Σχήμα 17: Συνδυασμός δύο μεταβλητών σε ξεχωριστούς Υ άξονες. 
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ΚΕΦΑΛΑΙΟ 6 
 
 
ΓΝΩΡΙΜΙΑ ΜΕ EAGLE 
 
 
   Το πρόγραμμα Eagle της εταιρείας CadSoft είναι ένα περιβάλλον σχεδίασης 

σχηματικών ηλεκτρονικών διαγραμμάτων και πλακετών. Μεταξύ άλλων 

περιλαμβάνει ένα σχεδιαστή διαγραμμάτων, ένα σχεδιαστή πλακέτας και τον 

αυτόματο δρομολογητή λωρίδων χαλκού.Η κατασκευή μιας πλακέτας ξεκινάει 

από τη δημιουργία του σχηματικού διαγράμματος του κυκλώματος, του οποίου 

θέλουμε να φτιάξουμε την πλακέτα, με τη βοήθεια του σχεδιαστή 

διαγραμμάτων. Στη συνέχεια δημιουργούμε το σχέδιο των λωρίδων χαλκού με 

τη βοήθεια του σχεδιαστή πλακέτας. Κάποιος μπορεί να ορίσει μόνος του τις 

διαδρομές του χαλκού ή να χρησιμοποιήσει τον αυτόματο δρομολογητή 

χάλκινων λωρίδων. Εάν το κύκλωμα είναι σχετικά μικρό, τότε κάποιος μπορεί 

να δημιουργήσει το σχέδιο της πλακέτας απευθείας στο σχεδιαστή πλακέτας 

χωρίς την δημιουργία σχηματικού διαγράμματος. Τέλος το σχέδιο 

αποτυπώνεται πάνω σε μια πλακέτα με διάφορες μεθόδους και ακολουθεί η 

αποχάλκωσή της. 

   Παρακάτω ακολουθούν οδηγίες βήμα προς βήμα για την δημιουργία μιας 

πλακέτας από την αρχή. 

   Αρχικά με το άνοιγμα του προγράμματος εμφανίζεται το Control Panel, σε 

αυτό βρίσκονται οι κύριες λειτουργίες όπως  η διαχείριση των 

βιβλιοθηκών(Libraries), η δημιουργία νέων εργασιών (Project) και κάποια 

παραδείγματα ολοκληρωμένων κυκλωμάτων. 
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    Για να δημιουργήσουμε ένα νέο project επιλέγουμε File>New>Project 

   Τότε κάτω από την κατηγορία Projects δημιουργείται ένα νέο project στο 

οποίο δίνουμε ένα όνομα σχετικό με τη εργασία μας. Με δεξί κλικ πάνω στο 

project επιλέγουμε New>Schematic (ή αν είμαστε ήδη στο project επιλέγουμε 

από το μενού File>New>Schematic) και ανοίγουμε τον σχεδιαστή 

διαγραμμάτων (schematic editor). 

 

 
 

 

 

   

 
 
 
 
 
 
 

 

    ΜΕΝΟΥ 

ΒΑΣΙΚΕΣ ΕΝΤΟΛΕΣ 

ΓΡΑΜΜΗ ΕΝΤΟΛΩΝ 

ΔΙΑΓΡΑΜΜΑΤΑ 

ΠΕΡΙΟΧΗ 
ΔΗΜΙΟΥΡΓΙΑΣ 

ΔΙΑΓΡΑΜΜΑΤΟΣ 

ΜΠΑΡΑ 

ΕΡΓΑΛΕΙΩΝ 
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   Η βασική περιοχή του προγράμματος χρησιμοποιείται για τη δημιουργία των 

σχηματικών διαγραμμάτων. Οι περισσότερες λειτουργίες του προγράμματος 

εκτελούνται το λιγότερο με 3 τρόπους. Οι πιο εύχρηστοι από αυτούς είναι:  

 

   Επιλογή εντολής από τη γραμμή μενού.  

 

   Επιλογή λειτουργίας από τη πλευρική μπάρα με τα εικονίδια εντολών ή από   

τη μπάρα των βασικών εντολών.  

 

   Πληκτρολόγηση και εκτέλεση εντολών στη γραμμή εντολών.  

 

   Με το άνοιγμα ενός νέου σχηματικού διαγράμματος το αποθηκεύουμε 

επιλέγοντας File>Save As. Γράφουμε το όνομα που επιθυμούμε και πατάμε 

Save. 

 
 

Επιλογή εξαρτημάτων 
 

   Αρχικά το πρώτο βήμα της σχεδίασης του σχηματικού είναι η επιλογή των 

εξαρτημάτων. Στο Eagle επιλέγουμε ταυτόχρονα είδος εξαρτήματος και είδος 

συσκευασίας του εξαρτήματος. Για παράδειγμα εάν επιλέξουμε ένα απλό 

τρανζίστορ, θα πρέπει ταυτόχρονα να επιλέξουμε εάν η συσκευασία του είναι 

TO-18, TO-92, TO-3 κ.ά. Το παράθυρο των εξαρτημάτων ανοίγει είτε 

επιλέγοντας το εικονίδιο Add   από τα εικονίδια εντολών είτε 

πληκτρολογώντας ADD στη γραμμή εντολών. 

 
 
 

 



ΣΥΓΚΡΙΣΗ  ΔΥΝΑΤΟΤΗΤΩΝ ΠΡΟΓΡΑΜΜΑΤΩΝ ΠΡΟΣΟΜΟΙΩΣΗΣ ΤΥΠΩΜΕΝΩΝ 

ΠΛΑΚΕΤΤΩΝ (PCB) 
 

68 
Αγγελίδης Γεώργιος , Αρβανίτης Νικήτας 

 

  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

    

   Στο αριστερό παράθυρο βλέπουμε τις διαθέσιμες βιβλιοθήκες εξαρτημάτων 

του Eagle, το μεσαίο παράθυρο χρησιμεύει για το σύμβολο του εξαρτήματος 

στο σχηματικό διάγραμμα και το δεξί παράθυρο για τη φυσική μορφή του 

εξαρτήματος στην πλακέτα. 

 
   Για να σταματήσουμε την επιλογή των εξαρτημάτων επιλέγουμε το εικονίδιο 

Cancel  . 
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Κύριες λειτουργίες του σχεδιαστή διαγραμμάτων 
 

 
Μετακίνηση εξαρτήματος 
 

     Δεξί κλικ πάνω στο εξάρτημα και επιλογή Move.  

 

-    Επιλογή του εικονιδίου Move    και στη συνέχεια επιλογή του 

εξαρτήματος.  

 
Μετακίνηση πολλών εξαρτημάτων 

   Αρχικά ξεκινάμε πατώντας το εικονίδιο Group  ,και στη συνέχεια 

επιλέγουμε τα εξαρτήματα που θέλουμε να μετακινήσουμε (κρατώντας 

πατημένο το αριστερό πλήκτρο του ποντικιού δημιουργούμε ένα ορθογώνιο 

μέσα στο οποίο θα υπάρχουν τα εξαρτήματα που θέλουμε). Επιλέγουμε το 

εικονίδιο Move    και στη συνέχεια κρατώντας πατημένο το πλήκτρο Ctrl 

(Control) κάνουμε δεξί κλικ πάνω στα επιλεγμένα εξαρτήματα και τα 

μετακινούμε όπου θέλουμε. Εναλλακτικά μπορούμε να κάνουμε δεξί κλικ πάνω 

σε ένα από τα εξαρτήματα που διαλέξαμε και επιλέγουμε Move: Group 

 

Περιστροφή εξαρτήματος 
 
 
    -     Επιλογή Rotate κάνοντας δεξί κλικ πάνω στο εξάρτημα. 

 

   -     Επιλέγουμε το Rotate     και στη συνέχεια το εξάρτημα. 
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Αντιστροφή εξαρτήματος 
 

   Για την δημιουργία του συμμετρικού σχήματος ενός εξαρτήματος κάνουμε τα 

εξής: 

 

-   Δεξί κλικ  στο εξάρτημα και επιλέγουμε το Mirror.  

 

-   Επιλέγουμε το Mirror    και έπειτα το εξάρτημα. 

 

 

Διαγραφή εξαρτήματος 
 

-   Δεξί κλικ στο εξάρτημα και επιλέγουμε το Delete.  

 

-   Επιλέγουμε το delete   και στη συνέχεια το εξάρτημα. 

 
Πολλαπλή διαγραφή εξαρτημάτων 
 

   Επιλέγουμε το εικονίδιο  ,έπειτα επιλέγουμε τα εξαρτήματα που θέλουμε 

να διαγράψουμε (κρατώντας πατημένο το αριστερό πλήκτρο του ποντικιού 

σχηματίζουμε ένα ορθογώνιο μέσα στο οποίο θα υπάρχουν τα εξαρτήματα 

που θέλουμε να διαγράψουμε). Επιλέγουμε από την μπάρα εντολών το Delete 

 και στη συνέχεια κρατώντας πατημένο το Ctrl (Control) κάνουμε δεξί κλικ 

πάνω στα επιλεγμένα εξαρτήματα για τα διαγράξουμε. Εναλλακτικά μπορούμε 

να κάνουμε δεξί κλικ πάνω σε ένα από τα εξαρτήματα που διαλέξαμε και  μετά 

να επιλέξουμε Delete: Group αντί για το συνδυασμό Ctrl και δεξί κλικ που 

χρησιμοποιήσαμε προηγουμένως. 
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Όνομα και τιμή εξαρτημάτων 
 

   Στα εξαρτήματα που έχουμε επιλέξει για το δικό μας κύκλωμα μπορούμε να 

δώσουμε ότι ονόματα εμείς επιθυμούμε.Επιπλέον μπορούμε σε κάποια 

εξαρτήματα(όπως για παράδειγμα αντιστάσεις)να δώσουμε συγκεκριμένες 

τιμές. Για την επιλογή ονόματος των εξαρτημάτων χρησιμοποιούμε το εικονίδιο 

Name  ή εναλλακτικά δεξί κλικ πάνω στο εξάρτημα και επιλέγουμε 

Name.Για όποια εξαρτήματα μπορούν να έχουν τιμή επιλέγουμε το εικονίδιο 

Value  ή κάνουμε δεξί κλικ πάνω στο εξάρτημα και στη συνέχεια Value. 

 
Αντικατάσταση εξαρτήματος 
 

   Για να αντικαταστήσουμε τη συσκευασία ενός εξαρτήματος κάνουμε δεξί κλικ 

πάνω στο εξάρτημα και μετά επιλέγουμε Replace. Τότε ανοίγει ένα παράθυρο 

με τις διαφορετικές συσκευασίες του εξαρτήματός μας για να επιλέξουμε όποια 

εμείς επιθυμούμε. 

 

 
Σύνδεση και έλεγχος εξαρτημάτων 
 

   Αφού τοποθετήσουμε τα εξαρτήματα στις θέσεις τους τα ενώνουμε μεταξύ 

τους χρησιμοποιώντας το εικονίδιο Net  ή πληκτρολογούμε στη γραμμή 

εντολών την εντολή net. Τότε εμφανίζεται ένα μικρό μενού όπου μπορούμε να 

επιλέξουμε τη μορφή που θέλουμε να έχει το καλώδιό μας όταν θα σχηματίζει 

γωνίες. 
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   Για την ένωση δύο εξαρτημάτων κάνουμε αριστερό κλικ στον ακροδέκτη του 

ενός εξαρτήματος και στη έπειτα αριστερό κλικ στον ακροδέκτη του άλλου. 

Μπορούμε να αλλάξουμε τη γωνία ενός καλωδίου κάνοντας αριστερό κλικ εκεί 

που χρειάζεται γωνία.Η γραμμή σταματάει πατώντας Esc(Escape) ή πατώντας 

το Cancel  . 

 

   Τέλος μπορούμε να κάνουμε έλεγχο σφαλμάτων χρησιμοποιώντας δύο 

διαφορετικές εντολές: 

 

 - Έλεγχος συνδέσεων (ERC – Electrical Rule Check): Επιλέγουμε το εικονίδιο 

ERC   ή  από το μενού Tools> ERC.  

 - Γενικός έλεγχος (Errors): Περιλαμβάνεται και ο έλεγχος συνδέσεων. 

Επιλέγουμε το εικονίδιο Errors   ή από το μενού Tools>Errors.  

 

 

Αν δεν έχουμε λάθη μπορούμε να προχωρήσουμε στον σχεδιαστή πλακέτας. 

 
Σχεδιαστής πλακέτας (PCB Editor) 
 

   Επιλέγουμε το εικονίδιο Board  και ανοίγει ένα παράθυρο το οποίο μας 

ενημερώνει ότι το αρχείο δεν υπάρχει (ανοίγει μόνο την πρώτη φορά που 

επιλέγουμε Board για ένα σχηματικό διάγραμμα).Απαντάμε Yes για την 

δημιουργία του αρχείου και τότε ανοίγει το παράθυρο του σχεδιαστή πλακέτας. 
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   Ο σχεδιαστής πλακέτας είναι παρόμοιος  με το σχεδιαστή διαγραμμάτων και 

έχουμε πολλές κοινές λειτουργίες  και στα δύο προγράμματα.Στο κάτω 

αριστερό μέρος του  βρίσκονται τα εξαρτήματα που χρησιμοποιήσαμε στον 

σχεδιαστή διαγραμμάτων μαζί με τις συνδέσεις τους. Αυτές οι συνδέσεις θα 

μετατραπούν σε συνδέσεις χαλκού.Το μεγάλο ορθογώνιο μέσα στην περιοχή 

δημιουργίας της πλακέτας δηλώνει τις φυσικές διαστάσεις της. 
   
 
  

Μενού 

Βασικές Εντολές 

Γραμμή Εντολών 

Όρια πλακέτας Μπάρα 

εργαλείων 

Περιοχή δημιουργίας 

πλακέτας 
Εξαρτήματα 
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   Αρχικά ορίζουμε το πλέγμα όπως και στο σχεδιαστή διαγραμμάτων Display 

>On και Size 0.05 inch.Τα εξαρτήματα τα χειριζόμαστε όπως ακριβώς και στο 

σχεδιαστή διαγραμμάτων, τα μεταφέρουμε πάνω στην πλακέτα όπου θέλουμε. 

Μια διαφορά υπάρχει στο Rotate,όπου τα εξαρτήματα μπορούν να 

περιστραφούν σε διάφορες γωνίες.Αν οι συνδέσεις είναι μπλεγμένες, τότε 

χρησιμοποιηούμε την εντολή Ratsnest και γίνεται αυτόματη επιλογή της 

καλύτερης διαδρομής. Αυτό πραγματοποιείται με την επιλογή του εικονιδίου 

Ratsnet  ή επιλέγοντας από το μενού Tools>Ratsnet.Η θέση των 

συνδέσεων μεταξύ των εξαρτημάτων δεν επηρεάζει τις επιλογές μας για τη 

τοποθέτηση των γραμμών του χαλκού. 

 

   Αν πατήσουμε αριστερό κλικ πάνω στο μέσο ενός ορίου της πλακέτας και 

κρατώντας το πατημένο, μπορούμε να μεγαλώσουμε ή να μικρύνουμε το 

μέγεθος της πλακέτας. Στη συγκεκριμένη περίπτωση τη μικραίνουμε. 
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Γενικοί Κανόνες Σχεδίασης 
 

   Πριν φτιάξουμε τις διαδρομές του χαλκού πρέπει να καθορίσουμε τους 

γενικούς κανόνες σχεδίασης. Επιλέγουμε λοιπόν Edit> Design Rules ή Tools> 

DRC από το μενού και ανοίγει το παράθυρο με τις παραμέτρους σχεδίασης. 

 

 

 

 

 

 

 

 

 

 

Ακολουθούν οι πιο σημαντικές επιλογές παρακάτω: 

 

-      Στο layers μπορούμε να καθορίσουμε τα επίπεδα της πλακέτας μας. Εάν 

κάνουμε κάποια αλλαγή, το Eagle θεωρεί ότι έχουμε πλακέτα διπλής όψης. 

Δεν θα το αλλάξουμε εφόσον μπορούμε να επιλέγξουμε αργότερα σε ποια 

πλευρά της πλακέτας επιθυμούμε να έχουμε τις συνδέσεις χαλκού.  

 

-   Στο Clearance και στο Distance ρυθμίζουμε τις ελάχιστες αποστάσεις 

μεταξύ των περιοχών χαλκού.  

 

-   Στο Sizes ρυθμίζουμε το ελάχιστο πάχος των λωρίδων χαλκού (αυτό 

επηρεάζει περισσότερο την αυτόματη δρομολόγηση).  

 

 -    Στο Restring ρυθμίζουμε το ελάχιστο μέγεθος των  περιοχών (pad) που θα 

κοληθούν τα εξαρτήματα. 
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Δρομολόγηση 
 

   Δρομολόγηση είναι η διαδικασία που καθορίζουμε τις λωρίδες χαλκού 

(Routing) και γίνεται είτε χειροκίνητα, είτε αυτόματα, είτε με συνδιασμό των 

δύο. 

   Στη χειροκίνητη δρομολόγηση χρησιμοποιώ την εντολή Route επλέγoντας το 

εικονίδιο Route  ή επιλέγοντας από το μενού Edit->Route. Τότε ανοίγει μια 

μπάρα με τις επιλογές της εντολής. 

 

 

 

 

 

   Οι σημαντικότερες επιλογές είναι το επιθυμητό πάχος της κάθε λωρίδας 

χαλκού και σε ποια πλευρά τις πλακέτας θα είναι οι λωρίδες. Επιλέγω λοιπόν 

την πλευρά 16 Bottom. Στη συνέχεια κάνω αριστερό κλικ στο ακροδέκτη ενός 

εξαρτήματος και αρχικοποιείται μια λωρίδα χαλκού. Κάνω γωνίες όπου θέλω 

πατώντας δεξί κλικ και την τερματίζω σε άλλον ακροδέκτη με αριστερό κλικ. 

   Εάν θέλω να σβήσω μια λωρίδα χαλκού τότε χρησιμοποιώ την εντολή Ripup 

επιλέγοντας το εικονίδιο Ripup  ή επιλέγοντας από το μενού Edit -> Ripup. 

Τώρα σε όποια λωρίδα χαλκού κάνω αριστερό κλικ αυτή σβήνει. Εάν θέλω να 

σβήσω όλες τις λωρίδες χαλκού τότε μετά την επιλογή της εντολής Ripup 

επιλέγω το εικονίδιο της εντολής GO  από τη μπάρα των βασικών εντολών. 

 

 

 

 

 
 

 
 
 

Επιλογή 

Πλευράς 

Χαλκού 

Επιλογή 

πάχους 

λωρίδας 
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  Στην αυτόματη δρομολόγηση χρησιμοποιώ την εντολή Auto επιλέγοντας το 

εικονίδιο Auto  ή επιλέγοντας από το μενού Tools -> Auto. Τότε ανοίγει το 

παράθυρο επιλογών του αυτόματου δρομολογητή. 
 
 
 
 
 
 
 
 
 
 
 
   Η σημαντικότερη επιλογή είναι η επιλογή των επιπέδων τα οποία θα 

χρησιμοποιήσει ο αυτόματος δρομολογητής για να καθορίσει τις λωρίδες 

χαλκού. Στη θέση General -> Preferred Directions μπορούμε να αποκλείσουμε 

ένα επίπεδο δηλώνοντάς το ως N/A (Not Available). Τα υπόλοιπα σύμβολα 

που είναι διαθέσιμα για κάθε επίπεδο είναι τα |, -, /, \ και *. Τα 4 πρώτα 

σύμβολα δηλώνουν την κατεύθυνση των λωρίδων που επιθυμούμε για αυτό το 

επίπεδο. Ο αστερίσκος δηλώνει οποιαδήποτε κατεύθυνση. Έτσι επιλέγουμε για 

το 1ο επίπεδο το N/A και για το 16ο επίπεδο το * (μιας και έχουμε επιλέξει μόνο 

ένα επίπεδο δεν έχει σημασία τι κατεύθυνση επιλέξαμε για αυτό το επίπεδο). 

Επιλέγοντας OK οι λωρίδες του χαλκού καθορίζονται αυτόματα. 

 

  Έχουμε τη δυνατότητα να φτιάξουμε ένα αριθμό λωρίδων χειροκίνητα και τότε 

να επιλέξουμε τον αυτόματο δρομολογητή. Σε αυτή την περίπτωση θα 

δημιουργηθούν αυτόματα οι λωρίδες χαλκού χωρίς να πειραχθούν οι 

χειροκίνητες. Άρα εάν έχουμε συγκεκριμένες απαιτήσεις και κάποιες λωρίδες, 

τότε τις φτιάχνουμε μόνοι μας και τις υπόλοιπες τις κάνουμε αυτόματα 
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  Μπορούμε να ελέγξουμε για λάθη, με την ίδια μέθοδο όπως και στο 

σχεδιαστή διαγραμμάτων. 

 

  Εάν επιθυμούμε να γεμίσουμε την πλακέτα με χαλκό (για γρήγορη 

αποχάλκωση ή RF κύκλωμα), τότε ακολουθούμε την εξής διαδικασία. 

Επιλέγουμε το εικονίδιο Polygon  ή επιλέγουμε Draw -> Polygon από το 

μενού. Κάνουμε αριστερό κλικ στις τέσσερις γωνίες της πλακέτας και 

δημιουργείται ένα περίγραμμα με διακεκομένη γραμμή. Στη συνέχεια κάνουμε 

δεξί κλικ πάνω στο περίγραμμα και επιλέγουμε Name. Δίνουμε σαν όνομα το 

GND εάν θέλουμε το γέμισμα να συνδέεται στη γείωση ή VCC για να συνδέεται 

στη τάση τροφοδοσίας. Τέλος εκτελούμε την εντολή Ratsnest, όπως έχουμε δει 

παραπάνω. 
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ΚΕΦΑΛΑΙΟ 7 

 
 

ΤΟ ΚΥΚΛΩΜΑ ΜΑΣ(8086) 

 
   Για να επιτύχουμε την σύγκριση των δύο προγραμμάτων, προχωρήσαμε στη 

σχεδίαση ενός κυκλώματος που περιλαμβάνει τον επεξεργαστή 8086. 

 

 
 
 
7.1 ΣΧΕΔΙΑΣΗ ΜΕ EAGLE 
 

-Αρχικά ανοίγουμε ένα καινούργιο project 

-File > New Project 

-Φορτώνουμε όλες τις βιβλιοθήκες για την εύρεση όλων των εξαρτημάτων 

-Βρίσκουμε ένα ένα το εξάρτημα από το button add που βρίσκεται αριστερά 

της οθόνης μας στην γραμμή εργαλείων 

-Στην συνέχεια χρησιμοποιούμε την εντολή invoke για να εμφανίσουμε τα 

power pins(ακροδέκτες τροφοδοσίας) 

-Συνδέουμε όλα τα απαραίτητα pins των εξαρτημάτων με την εντολή net 

-Δημιουργούμε τα address και τα data bus για να συνδέσουμε τις μνήμες με 

τον επεξεργαστή 

-Αφού έχουμε ολοκληρώσει το schematic και έχουμε κάνει όλες τις 

απαραίτητες συνδέσεις ελέγχουμε για τυχόν λάθη με την εντολή erc error 
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Σχημα 18: Το σχηματικό του κυκλώματός μας στο Eagle. 

 

 

 

-Στην συνέχεια το μετατρέπουμε σε board με την εντολή switch to board που 

βρίσκεται στο menu στην επιλογή file (file > switch to board) 

-Αυτό μας εμφανίζει το κύκλωμα μας σε επίπεδο pcb 

-Στο τέλος ρυθμίζουμε τις παραμέτρους όπως π.χ. το μέγεθος, το υλικό και τον 

τύπο της πλακέτας που θα χρησιμοποιήσουμε και χρησιμοποιούμε την εντολή 

autoroute η οποία υλοποιεί την βέλτιστη διάταξη των εξαρτημάτων με βάση 

τους κανόνες σχεδίασης pcb. 
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Σχημα 19: Το κύκλωμά μας σε ultiboard στο Eagle. 

 
 
7.2 ΣΧΕΔΙΑΣΗ ΣΤΟ ORCAD 
 

-Αρχίκα δημιουργούμε ένα καινούργιο project με την εντολή 

-File> New Project 

-Φορτώνουμε όλες τις βιβλιοθήκες για την εύρεση των εξαρτημάτων μας 

-Βρίσκουμε όλα τα εξαρτήματα ένα ένα και τα τοποθετούμε με την εντολή place 

part η οποία βρίσκεται δεξιά στην γραμμή εργαλειών 

-Ενώνουμε τα pins των εξαρτημάτων μας με την εντολή auto connect to points 

που βρίσκεται δεξιά στην γραμμή εργαλειών 

-Στην συνέχεια τοποθετούμε τα address και data bus και τα συνδέουμε με την 

εντολή auto connect to bus 

-Αφού έχουμε ολοκληρώσει το schematic κάνουμε προσομοίωση του 

κυκλώματος με την εντολή run pspice για να αναζητήσουμε τυχόν λάθη 
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Σχήμα 20: Το σχηματικό του κυκλώματός μας σε Orcad. 

 

-Έπειτα για την μετατροπή του schematic σε board ακολουθούμε τα εξής 

βήματα: 

i) Επιλέγουμε όλα τα εξαρτήματα 

ii) Right click> edit properties εκεί μας εμφανίζεται μια λίστα εξαρτημάτων και 

επίλεγοντας parts τοποθετούμε στην στήλη pcb footprints  ένα ένα σε κάθε 

εξάρτημα το αντίστοιχο footprint ώστε όταν μεταφέρουμε το κύκλωμα σε board               

να έχουμε το σωστό αποτύπωμα για κάθε εξάρτημα 

iii) Χρησιμοποιούμε τις εντολές annotate και create net list από τα Tools που 

είναι απαραίτητες για να προχωρήσουμε στο άλλο πρόγραμμα και να 

εμφανίσουμε το board μας πατώντας οκ στο παράθυρο που μας ανοίγει. 

iv) Ανοίγουμε το Allegro Pcb 

v) Από την πάνω μπάρα επιλέγουμε settings->outlines->board outline και 

πατάμε οκ 

vi) Έπειτα επιλέγουμε place->quickplace στην πάνω μπάρα και μετά πατάμε 

place και οκ 

vii) Στη συνέχεια επιλέγουμε ξανά setup-> constraints-> physical και κάνουμε 

έλεγχο αποστάσεων 
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viii) Επόμενο βήμα είναι να κάνουμε autoroute ώστε να τοποθετηθούν 

αυτόματα τα εξαρτήματα μας και οι αγωγοί με βάση τους κανόνες σχεδίασης, 

επιλέγοντας route->pcb router-> route automatic και πατάμε route 

ix) Τέλος ελέγχουμε της παραμέτρους από την επιλογή manufacture 

 

 
Σχήμα 21: Το κύκλωμά μας σε ultiboard στο Orcad. 

 

 
7.3 ΣΥΓΚΡΙΣΗ ΔΥΝΑΤΟΤΗΤΩΝ ΤΩΝ ΔΥΟ ΠΡΟΓΡΑΜΜΑΤΩΝ 

ΠΡΟΣΟΜΟΙΩΣΗΣ EAGLE ΚΑΙ ORCAD 
 
   Κατά την σχεδίαση και υλοποίηση του κυκλώματος μας στα δύο 

προγράμματα που προαναφέραμε (eagle και orcad) διαπιστώσαμε κάποιες 

λειτουργίες που θα τύχαιναν βελτίωσης. Το eagle είναι ένα πρόγραμμα που 

είναι πολύ πιο εύχρηστο και απλό σε αντίθεση με το orcad,αυτό του δίνει την  
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δυνατότητα να είναι προσβάσιμο από τον μαθητή μέχρι τον πιο έμπειρο 

σχεδιαστή. Σε αντίθεση με το orcad που ειδικά η μεταφορά του κυκλωματός 

μας από schematic σε board μας δυσκόλεψε πολύ επείδή χρειάζεται 

συνδυασμό προγραμμάτων για να το επιτύχεις. Επιπλέον το eagle μπορεί να 

βρεθεί πολύ οικονομικά,ακόμα και σε δωρεάν εκδόσεις.Από την άλλη το orcad 

είναι ένα πιο ακριβό εργαλείο αλλά πιο επαγγελματικό χρησιμοποιώντας 

περισσότερες βιβλιοθήκες. 

   Μία ακόμα διαφορά των δύο προγραμμάτων είναι στα αποτυπώματα των 

εξαρτημάτων λεγόμενα και ως footprints,που από την μία το eagle με το που 

τοποθετείς το κάθε εξάρτημα παίρνει το δικό του footprint απευθείας,ενώ στο 

orcad χρειάζεται αφού έχεις φτιάξει το schematic του κυκλώματος να πας σε 

κάθε εξάρτημα ξεχωριστά να τα τοποθετήσεις,βρισκοντάς τα ένα ένα,τα δικά 

τους footprints. 

   Όπως παρατηρήσατε και παραπάνω (στο σχήμα 21) κατά την λειτουργία του 

Autoroute στο Orcad δεν καταφέραμε να γίνει απόλυτα επιτυχής η διαδικασία 

παρόλο που δοκιμάσαμε αρκετές φορές την επανατοποθέτηση των 

εξαρτημάτων, ενώ στο Eagle είχαμε 100% επιτυχία από την πρώτη 

προσπάθεια. Επίσης μία ακόμα διαφορά των προγραμμάτων είναι και η 

δυνατότητα που υπάρχει για το eagle να χρησιμοποιεί επεκτάσεις που 

υπάρχουν στο διαδύκτιο για απεικόνιση των πλακετών σε τρισδιάστατη 

μορφή(3d).Από την άλλη η μεταφορά της πλακέτας μας από το orcad σε 

τρισδιάστατη μορφή είναι πιο πολύπλοκη. 

  

 

 

  Μία ιστοσελίδα που μπορεί να εξυπηρετήσει αυτό το σκοπό είναι 

dbrdviewer.cytec.bg μέσα από την οποία έγινε και η δικιά μας μετατροπή στο 

eagle και την παραθέτουμε παρακάτω. 
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ΣΥΓΚΡΙΣΗ  ΔΥΝΑΤΟΤΗΤΩΝ ΠΡΟΓΡΑΜΜΑΤΩΝ ΠΡΟΣΟΜΟΙΩΣΗΣ ΤΥΠΩΜΕΝΩΝ 

ΠΛΑΚΕΤΤΩΝ (PCB) 
 

89 
Αγγελίδης Γεώργιος , Αρβανίτης Νικήτας 

 

 

 

   Τέλος θα θέλαμε να αναφέρουμε την δυνατότητα που μας δίνεται μέσω του 

eagle να παράξουμε μέσω διαδικασιών/βημάτων αντίγραφο του σχεδίου μας 

συμβατό με άλλες γενεές προγραμμάτων(vector) ώστε να μπορούμε να το 

επεξεργαστούμε περαιτέρω. Για παράδειγμα ασχοληθήκαμε ιδιαίτερα με την 

διασύνδεση με το πρόγραμμα Αutocad διατηρώντας και τις ιδιότητες των 

επιπέδων. 
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